CONTENTS

WELCOME .................................................................................................................................................. 3
OVERVIEW .................................................................................................................................................. 3
BEFORE YOU BEGIN THE INSTALLATION ................................................................................................. 3
AMLIB Supported Operating Systems & System Requirements ................................................................. 4
SECTION 1: AMLIB CLIENT INSTALLATION ............................................................................................ 5
   Step 1: Log All Users out of Amlib (Server Migrations Only) ................................................................. 5
   Step 2: Install the Amlib 5.4 Client ........................................................................................................... 5
   Step 3: Icon Utility for Shared Amlib Folder Installation ........................................................................ 11
SECTION 2: CREATING AND LOADING DATABASES ................................................................................. 12
   Step 1: Create the Live Amlib Databases ................................................................................................. 12
   Step 3: Create the Test Amlib Databases ................................................................................................. 14
   Step 4: Load Amlib Databases ................................................................................................................ 14
   Step 6: Setup User Security .................................................................................................................... 20
SECTION 2B: ORACLE RDBMS .................................................................................................................. 26
   Step 1: Oracle Configuration Required Before Amlib Installation ......................................................... 26
   Step 2: Oracle Character Set ................................................................................................................ 27
   Step 3: Create Initial Database, Tablespace and Sufficient Rollback Space ......................................... 27
   Step 4: Install Oracle Client and Configure SQL*Net (Net8) .................................................................. 28
   Step 5: Run SQL*Plus To Assign Default Tablespace & Create Amlib Logins ...................................... 31
   Step 6: Load Amlib Database into Oracle .................................................................................................. 32
   Step 7: Configure SQL.ini Settings ........................................................................................................ 32
SECTION 3: BACKUPS ............................................................................................................................. 34
SECTION 4: TROUBLESHOOTING TIPS .................................................................................................... 35
   Step 1: Check Communication to Database Server using Microsoft Port Query .................................... 35
   Step 2: Next Level of Amlib Troubleshooting ....................................................................................... 37
   Cannot Connect User ................................................................................................................................ 40
   Frequently Asked Questions .................................................................................................................... 42
AMLIB RDBMS DATABASE STRUCTURE ............................................................................................... 44
   Database Structure for Microsoft SQL Server (MSSQL) ........................................................................... 44
   Database Setup for Oracle ........................................................................................................................ 44
APPENDICES ............................................................................................................................................. 45
   Appendix A: Silent Mode Command Line Parameters ............................................................................. 45
   Appendix B: Generate Encrypted RDBMS Password .............................................................................. 47
   Appendix C: MICROSOFT SQL SERVER 2008 R2 install ..................................................................... 48
Welcome to the Amlib Client 5.4 Installation Guide for new installations of Amlib (not for upgrades).

Details on installing other optional components (such as NetOpacs, ZServer and DIY Self Issues) are available in separate module specific Installation Guides.

Overview

The installation of the Amlib client involves the following steps:

1. Install the Amlib Client 5.4 application
2. Install the database server:
   a. MS SQL Server 2008 R2 (Appendix C)
   b. Oracle
3. Create and configure Amlib databases
4. Configure the Amlib database connection settings
5. Install Amlib Client 5.4.x patches (where applicable, see separate documentation)

Before you begin the installation...

Read the Installation Notes First

Please carefully read the entire installation guide prior to commencing the actual Amlib installation.

If you have any questions please log a TOPdesk request at https://servicedesk.oclc.org/tas/public/index.jsp. If you do not know your TOPdesk login please email support-amlib@oclc.org and we will send it to you.

This installation process is for NEW installations only. This documentation should NOT be used for upgrades. Follow the instructions precisely.

If You Use Gupta (Centura) SQLBase with Amlib (Existing Server Migrations Only)

- Amlib Client 5.4 does not support Gupta SQLBase
- You will need to migrate your database software to SQL Server (see separate guide)
- For additional information on migrating to SQL Server, please contact Amlib Support

Serial Numbers Required for Installation of Amlib Modules

The Amlib Client 5.4 installation requires a serial number. You must contact Amlib Support via TOPdesk to receive your serial keys for the modules that your library has purchased.
## AMLIB SUPPORTED OPERATING SYSTEMS & SYSTEM REQUIREMENTS

### Database Server

| Operating System | • Windows 2003, 2008 (R2)  
|                  | • Linux (and Unix)  
| RDBMS            | • Microsoft SQL Server 2005, 2008 (R2)  
|                  | • Oracle 9i, 10g, 11gR2  
| Memory (RAM)     | • Depends on operating system, volume & RDBMS selected  
|                  | • Minimum 2GB RAM for SQL Server  
|                  | • Minimum 2GB RAM for Oracle  
| Hard Disk        | • Depends on volume. Using multiple Fast SCSI-3 Disk Drives (for example: more SCSI drives provides better performance)  
| Backup           | • Removable backup device (for example: 4mm DAT Tape Drive)  

### NetOpacs (Web Opac) Application Web Server

| Operating System | • Windows 2003, 2008 with IIS pre-installed  
| Memory (RAM)     | • Depends on operating system and volume  
|                  | • Minimum 2GB RAM for Windows 2003/2008  

*Please Note:* Although NetOpacs can operate on the same Amlib Database Server, it is recommended that medium to large libraries should implement a dedicated NetOpacs Server for maximum performance & security.

### PC Client (for Client Server Modules including Offline)

| Operating System | • Windows XP, Vista, Windows 7  
| Memory (RAM)     | • Minimum 256 Mb for Windows XP  
|                  | • Minimum 1GB for Windows 7  
|                  | • Minimum 1GB for Windows Vista  
| Display          | • SVGA (800x600) minimum  
| Web Browser      | • Internet Explorer 7 and above (will also work with other JAVA enabled browsers)  

- **Important Note:** the above requirements are provided as a general guideline only
SECTION 1: AMLIB CLIENT INSTALLATION

Default Installation Folders

To assist with support we highly recommend that the default installation folders suggested in the following notes are retained.

For example:

- **Amlib Client software:** C:\Amlib (or D:\Amlib, E:\Amlib)

Step 1: Log All Users out of Amlib (Server Migrations Only)

- Ensure all users have logged out of the *Amlib* client
- Libraries using *NetOpacs* will need to ensure that the *NetOpacs* program has been shutdown on the web server(s)
- *OCLC (UK) Limited* recommends that the library verify that it has an up-to-date backup of its database (for example: from the previous night) before installing any updates

Step 2: Install the Amlib 5.4 Client

**IMPORTANT:** Please ensure that you have full read/write access to the \Amlib folder on your server (for example: C:\Amlib) and that you are logged in with Administrative Privileges.

1. The *Amlib Client 5.4* installer is available on the OCLC Website, under Setup Programs>Amlib Client: https://www.oclc.org/support/services/amlib/downloads-software-updates/version5-4/setup-programs.en.html (contact *Amlib* support if you require a login to this website)
2. Download the *Amlib54Setup.exe* and save it on your *Amlib* server
3. Double-click the *Amlib54Setup.exe* to launch the installation Wizard – the Setup – Amlib Client screen will open displaying the Welcome message:
4. Click the **Next** button – the **Serial** screen will display, prompting you for a valid **Serial Number**:

![Serial Screen]

5. Enter the **Serial Key** supplied by **OCLC (UK) Ltd** (case sensitive!)

6. Click the **Next** button – the **Installation Location** screen will be displayed:

![Installation Location Screen]

7. Enter the drive/folder location where you would like to install the **Amlib Client** – we recommend that the **Amlib Client** be installed in **C:\Amlib** (or **D:\Amlib**, etc)
8. Click the **Next** button – the **Select Components** window will display:

![Select Components Window](image)

9. **Choose** which components should be installed:

   a. **Modules To Install**:

      - **Amlib Staff User (Full)** – installs Amlib Staff Client (catalogue, circulation, etc.)

      - **Amlib Opac Only** – only installs the Amlib Client Server OPAC module (*only select this option if you installing on a Public Access workstation*)

   b. **Report Template Paper Format**:

      - **A4 (Australia, UK, Europe)** – installs the *Amlib* report templates formatted for A4 paper type

   c. **Admin Tasks**:

      - **Modify Amlib Database (dba) Login Configuration** – *only select this option if you wish to change the hidden Database login and password to internally connect to the Amlib database(s)*


---

**Database Login and Password**

When setting up the *Amlib* databases (*AMCAT, AMLIB, AMLOCAL, AMSTATS, AMWEB*, etc), the user can define a series of RDBMS logins which allows the *Amlib Client* (and other components such as the *NetOpacs*) to connect with the *Amlib* databases. The *Amlib Client 5.4* installer configures an (encrypted) default login and password of **SYSADM/SYSADM**.

10. Select options and click the **Next** button
11. The Database Relation Management System (RDBMS) screen will display:

![Database Relation Management System](image)

**Please Note:** Gupta SQLBase is not supported by Amlib version 5.4. Please contact Amlib Support if you are migrating a Gupta SQLBase database.

12. Please select the RDBMS you are using:
   a. If your library is using Microsoft SQL Server for Amlib:
      i. Select the Microsoft SQL Server radio button
      ii. Click the Next button – the **Configure the SQL ini file** screen will display prompting you for additional information:

   ![Configure the SQL ini file](image)

   (The SQL.ini file is a configuration file containing the pathway information which allows the Amlib Client (and other components such as the NetOpacs) to connect with the Amlib databases)
- Please enter the (SQL Server) database server name – default display is current local machine name (for example: tardis)
- Please enter the database server IP address – default display is current local machine IP address (for example: 127.0.0.1 for localhost)
- Please enter the SQL Server ODBC driver name – the driver name is normally SQL Server so there is no need to change this field

iii. Enter options and click the Next button

b. If your library is using Oracle for Amlib:
   i. Select the Oracle radio button
   ii. Click the Next button

13. If you selected Modify Amlib Database (dba) Login Configuration at step 9 above, the RDBMS Login to be used with Amlib screen will display:

![RDBMS Login screen](image)

Notes:
- This will be the RDBMS Login that Amlib will use as a *HIDDEN* Amlib Database (DBA) Login to connect the Client to the database
- An encrypted User and Password can be entered (generated using the Amlib nopasswd.exe utility – see Appendix B: Generate Encrypted RDBMS Password)
- This will be stored within the {windows}\amlib.ini configuration file

14. To accept the defaults (for most customers), click the Next button
15. The Select Start Menu Folder screen will display:

![Select Start Menu Folder](image)

16. To accept the default name (for most customers), click the Next button.

17. The Select Additional Tasks screen will display prompt if you wish to install a desktop icon for the Amlib Client:

![Select Additional Tasks](image)

18. (You can unselect Install desktop icons for selected Components if you do not wish to install the Amlib icons on the desktop)

19. Click the Next button to continue.
20. The Ready to Install screen will display with a summary of the installation tasks to be performed:

![Ready to Install Screen](image)

21. Click the Install button – the Installing screen will display
22. When complete click the Finish button
23. The setup Wizard will close

Installation of the *Amlib Client 5.4* is now complete.

**Step 3: Icon Utility for Shared Amlib Folder Installation**

If you decide to install the *Amlib* client in a shared folder on a central server for access by all client PCs (for example: `L:\Amlib`), each PC needs to have the `\Amlib` folder in the PATH environment (`autoexec.bat` for Win 98 or Control Panel `\System\Environment` for Win 2000/XP), as well as having the required *Amlib* icons created.

The *Amlib iconsetup.exe* utility is provided to automate this task:

- Drive:`\Amlib\Utility\Icons\iconsetup.exe`

See separate instructions for *Iconsetup.exe* installation.
SECTION 2: CREATING AND LOADING DATABASES

Step 1: Create the Live Amlib Databases

The following notes will assist with the creation of the Live Amlib databases in Microsoft SQL Server 2008 R2.

1. Launch the SQL Server Management Studio (Start > All Programs > Microsoft SQL Server 2008 R2)

2. Right-click on the Databases folder in the sidebar and select New Database...

1. The New Database screen will display:

2. Type in the first Database name – for example: AMCAT
3. In the Database files section, **AMCAT** row:
   a. In the **Initial Size (MB)** column, adjust the initial size from 3 (Mb) to **10** (Mb)
   b. In the **Autogrowth** column, click the ... button for the **AMCAT** row – the **Change Autogrowth for AMCAT** screen will display:
   
   ![Change Autogrowth for AMCAT](image)
   
   c. Ensure that:
      i. **File Growth** = **10** (In Percent)
      ii. **Maximum File Size** = **Unrestricted File Growth**
   
   d. Click the **OK** button

4. Repeat step 5 for the **AMCAT_log** row in the **Database files** section

5. In the sidebar, select the **Options** page, ensure the **Recovery model** drop-down is set to **Simple** and then click the **OK** button when complete:
6. If you expand the **Databases** folder you should see your new database listed there:

   ![Database Tree](image)

7. Repeat steps 1 - 7 for your other databases: **AMLIB**, **AMLOCAL**, **AMSTATS** and **AMWEB** (where applicable)

   **ADVANCED HINT**: The speed of the writing of files can be increased by splitting the db and log files across separate drives (unnecessary in a RAID setup).

---

**Step 3: Create the Test Amlib Databases**

*Amlib* provides the facility for customers to have a separate **Test** database area for *Amlib* – which is ideal for sites to use in-house for training of new staff without affecting the **Live** database, or to load (and test) new software releases before applying to the production (**Live**) database.

To create a **Test** database for *Amlib* follow above steps **except** for the following changes:

- Database names should be **TECAT**, **TELIB**, **TELOCAL**, **TESTATS** and **TEWEB** (where applicable)

---

**Step 4: Load Amlib Databases**

In nearly all instances, a previously configured set of databases will be installed in the **MSSQL** environment. This will either be a set of databases provided by **OCLC (UK) Amlib** following a site conversion, or a set of databases previously backed up on another server (server migrations only).

In some instances, these backed up databases will have been configured for an **Oracle** or **SQLBase** environment and will need to be converted to be compatible with a **SQL Server** environment (see separate instructions).

**Restore Live Databases**

For ease of loading, the databases to be loaded should be copied into the **C:\Program Files\Microsoft SQL Server\MSSQL10_50.SQLEXPRESS\MSSQL\Backup** folder on the new server.

1. Launch the **SQL Server Management Studio**

2. Expand the **Databases** selection tree [+]

---
3. Right-click on the **AMCAT** database and select **Tasks > Restore > Database...** – the **Restore Database** screen will display:

![Restore Database Screen]

1. Select the **From device**: radio button
2. Click the ... (Select Devices) button – the **Specify Backup** screen will display:

![Specify Backup Screen]
3. Click the Add button – the Locate Backup File screen will display:

4. Select the corresponding AMCAT.BAK file

5. Click the OK button to return to the Specify Backup screen:
6. Click the **OK** button to return to the **Restore Database** screen:

![Restore Database Screen]

7. **Tick** the **Restore** box for the selected database

8. Click the **OK** button to return to the **Specify Backup** screen:

![Specify Backup Screen]
9. Click the OK button to return to the Restore Database screen:

10. Tick the Restore box for the selected database

11. In the left side-bar, select the Options page:
12. **Restore options:**
   - Select **Overwrite the existing database (WITH REPLACE)**

13. **Recovery state:**
   - Select **Leave the database ready to use by rolling back uncommitted transactions. Additional transaction logs cannot be restored (RESTORE WITH RECOVERY)**

14. Click the **OK** button – the database will be restored

15. The following message will appear when complete: **The restore of the database XXXX completed successfully.**

![Image](image1.png)

16. Repeat steps 2-15 for all the **AM** databases

**Transaction Logging**

1. The final step involves going into **Microsoft SQL Server Management Studio**, right-clicking on your **AMCAT** database and selecting **Properties**:

![Image](image2.png)

2. The **Database Properties** screen will display – in the sidebar, select the **Options** page:

![Image](image3.png)

3. In the **Recovery model** drop down box change the selection to: **Full**

4. Do this for the other databases: **AMLIB, AMLOCAL, AMSTATS** and **AMWEB** (where installed)
Step 6: Setup User Security

Once all the databases have been created, you will need to set up the user security logins.

Clear User Schema

It may be necessary to clear the old user schema first.

1. Click the **New Query** button – this will open up a new SQL Query screen

2. Type (or copy) in the following:

   ```sql
   use AMCAT
   drop schema SYSADM
   drop user SYSADM

   use AMLIB
   drop schema SYSADM
   drop user SYSADM

   use AMLOCAL
   drop schema SYSADM
   drop user SYSADM

   use AMSTATS
   drop schema SYSADM
   drop user SYSADM

   use AMWEB
   drop schema SYSADM
   drop user SYSADM
   ```

3. Click the **Execute** button

4. Repeat, replacing **SYSADM** with **NETOPACS**
Map User Schema

1. In the sidebar, expand the Security folder, right-click on Logins folder and select New Login...

2. The Login - New screen will display:

3. On the General page (select from sidebar):
   a. Select the SQL Server authentication radio button
   b. Enter the following details:
      i. Login name: SYSADM
      ii. Password: SYSADM
      iii. Confirm password: SYSADM
   c. Deselect the Enforce password policy tick box
4. On the User Mapping page (select from sidebar):

5. In the Map column tick the AMCAT database option
6. Then tick the db_owner option in the lower screen
7. Repeat steps 5 and 6 for the AMLIB, AMLOCAL, AMSTATS and AMWEB (where installed) databases
8. Click the OK button to exit out of this screen
9. Repeat steps 1 – 8 to add in the NETOPACS (where the Netopacs are installed) login
10. When you are done, your logins will show under Security > Logins:
These logins should also display under each database > Security > Users:

- Databases
  - System Databases
  - AMCAT
    - Database Diagrams
    - Tables
    - Views
    - Synonyms
    - Programmability
    - Service Broker
    - Security
      - Users
        - dbo
        - guest
        - INFORMATION_SCHEMA
        - sys
        - SYSSADM
        - APNET
        - NETOPACS
      - Roles

Link the Amlib Client to the Live Database

1. On the Amlib server, navigate to your Amlib folder and open up the SQL.ini file in Notepad:

2. Under the heading [Odbcrr] enter in the SQL Server file paths for the Live and Test databases:

   - REMOTEDBNAME=AMCAT,DRIER=SQL Server;SERVER=SERVERNAME\INSTANCENAME;DATABASE=AMCAT
   - REMOTEDBNAME=AMLIB,DRIER=SQL Server;SERVER=SERVERNAME\INSTANCENAME;DATABASE=AMLIB
   - REMOTEDBNAME=AMLOCAL,DRIER=SQL Server;SERVER=SERVERNAME\INSTANCENAME;DATABASE=AMLOCAL
   - REMOTEDBNAME=AMSTATS,DRIER=SQL Server;SERVER=SERVERNAME\INSTANCENAME;DATABASE=AMSTATS
   - REMOTEDBNAME=AMWEB,DRIER=SQL Server;SERVER=SERVERNAME\INSTANCENAME;DATABASE=AMWEB
   - REMOTEDBNAME=TECAT,DRIER=SQL Server;SERVER=SERVERNAME\INSTANCENAME;DATABASE=TECAT
   - REMOTEDBNAME=TELIB,DRIER=SQL Server;SERVER=SERVERNAME\INSTANCENAME;DATABASE=TELIB
   - REMOTEDBNAME=TELOCAL,DRIER=SQL Server;SERVER=SERVERNAME\INSTANCENAME;DATABASE=TELOCAL
   - REMOTEDBNAME=TESTATS,DRIER=SQL Server;SERVER=SERVERNAME\INSTANCENAME;DATABASE=TESTATS
   - REMOTEDBNAME=TEWEB,DRIER=SQL Server;SERVER=SERVERNAME\INSTANCENAME;DATABASE=TEWEB

* Replace SERVERNAME with the actual SQL Server name and INSTANCENAME with the actual instance (the default instance name is usually SQLEXPRESS). These can be seen when you log into SQL Server:
Verify Connectivity

1. On the Amlib server, navigate to your Amlib folder
2. Locate and double-click on the Upgrade.exe application:
3. The Amlib Upgrade application will launch:
4. From the menu, select File > Advanced Login... – the Advanced Login prompt will display:

![Advanced Login Dialog Box]

5. Login with SYSADM/SYSADM, enter in Database AMCAT and click the OK button

6. Exit from the Upgrade.exe application
SECTION 2B: ORACLE RDBMS

Step 1: Oracle Configuration Required Before Amlib Installation

Since the installation and configuration of the Oracle RDBMS is a complex process OCLC (UK) requires that the customer have their Oracle Data Base Administrator (DBA) to initially setup the required Amlib instances (or databases), rollback, tablespaces, backup and ongoing maintenance.

They are:

Create Two (2) Oracle Instances: AMLIB (Live database) and TELIB (Test database)

For libraries using Microsoft SQL Server RDBMS OCLC (UK) normally recommends create five (5) separate databases for the Live database (AMCAT, AMLIB, AMLOCAL, AMSTATS and AMWEB), but many Oracle sites choose to create a single database (instance) only since having five (5) databases creates higher overheads in Oracle. This decision will depend on the customer requirements (for example: for a Mobile library for replication of the AMLIB tables only).

- Refer to the section “Create Amlib Live and Test Instances for Oracle” for additional information

Create Initial Database, Tablespace and Sufficient Rollback Space

Require for both AMLIB (Live) and TELIB (Test) environment. For the TELIB instance a tablespace of 500 Mb will be sufficient. Sizing of the AMLIB instance will depend on the customer volume, and available disk space on the server.

Suitable sizing may be: Customer with 100,000 bibliographic records 8 to 10 Gb AMLIB_DB tablespace, 1 Gb rollback space. Customer with 200,000 bibliographic records 15 to 20 Gb AMLIB_DB tablespace, 2 Gb rollback space.

- Refer to the section “Create Amlib Live and Test Instances for Oracle” for additional information

Install Oracle Client (SQL*Net or Net8) on each PC

The Oracle Client (also known as SQL*Net or Net8) needs to be installed an EACH PC workstation that will be using the Amlib Library Management System, as well as the web server running the Amlib NetOpacs software. Oracle SQL*Net is the Oracle client “driver” for Windows Client Server applications to seamlessly connect to an Oracle database. Oracle SQL*Net should be setup with two database “aliases” (if only using 2 Oracle instances) – these are AMLIB (which should reference the AMLIB instance on the Oracle database server) and TELIB (which should reference the TELIB instance on the Oracle database server)

If a customer does not have an Oracle DBA available to install, configure and maintain their Oracle RDBMS Amlib we will be able to provide details of a suitable Oracle DBA contractor.

Otherwise we recommend that the customer select the Microsoft SQL Server RDBMS.

Task required after installation and conversion to Amlib:

Setup Backup Facilities for Oracle and Database server
Libraries should identify whether to use Oracle "Hot" backups (online backups for 24-hour database access) or Oracle "Cold" backups (where the database is shutdown before being copied to tape). The type of backup used will also impact on the Oracle database setup (for example: allowing for archive log space for online backups).

**Step 2: Oracle Character Set**

For Oracle 8.1.7, OCLC (UK) recommends that the AMERICAN_AMERICA.WE8ISO8859P1 character set (8-bit Western European) is used when installing Oracle and creating the instances rather than the default US 7-bit ASCII.

If OCLC (UK) is providing the data conversion services to the library then the AMERICAN_AMERICA.WE8ISO8859P1 character set will provide greater accuracy when loading the converted data files.

For Oracle 9.2 on Windows 200x, OCLC (UK) recommends that the WE8MSWIN1252 character set is used. Please advise OCLC (UK) of the Oracle character set configured on your server prior to the commencement of the data conversion process.

**Step 3: Create Initial Database, Tablespace and Sufficient Rollback Space**

When configuring the AMLIB and TELIB instances within Oracle we recommend the following settings:

**AMLIB Instance**

Recommend creating a separate tablespace AMLIB_DB to hold the Amlib tables.

Sizing of the AMLIB_DB tablespace will depend on the customer volume, and available disk space on the server.

Suitable sizing may be:

- **Customer with 100,000 bibliographic records** 8 to 10 Gb AMLIB_DB tablespace, 1 Gb rollback space.
- **Customer with 200,000 bibliographic records** 15 to 20 Gb AMLIB_DB tablespace, 2 Gb rollback space

During the Amlib data load the tablespace AMLIB_DB is assigned as the default tablespace for the Amlib tables. Your Oracle DBA should ensure that the tablespace of AMLIB_DB and the temporary tablespace (for example: TEMP) should be assigned as a default to all users created by library system administrators within Amlib.

**TELIB Instance**

Recommend creating a separate tablespace AMLIB_DB to hold test Amlib tables.

For the TELIB instance a size of 500 Mb will be sufficient for the AMLIB_DB tablespace.

During the TELIB data load the tablespace AMLIB_DB is assigned as the default tablespace for the Test Amlib tables.
IMPORTANT: However, in many cases the library wish to have the initial trial conversion loaded into the Test database. In this case we would recommend creating an AMLIB_DB tablespace of 3 Gb with 200 to 400 Mb Rollback space.

Other Performance Suggestions

To maximise performance OCLC (UK) also suggest:

- Locating Oracle database and log files across multiple hard disks as possible (not required if the server is configured for RAID 5)
- Setting the AMLIB_DB tablespace and Rollback logs set to automatically extend in size
- At some stage in the future export the entire AMLIB database and recreate/reload to have Oracle recalculate and optimise table extents used

Step 4: Install Oracle Client and Configure SQL*Net (Net8)

The Oracle Client needs to be installed an EACH PC workstation that will be using the Amlib Library Management System, as well as the web server running the Amlib NetOpacs software.

After installing the Oracle Client, SQL*Net (also known as Net8 in Oracle version 8) needs to be configured with the Amlib Live and Test databases and the address of the Oracle database server.

The following is a brief example for configuring the Oracle Net8 Client for Oracle Version 8.1.7.

1. Select the Net8 Configuration Assistant icon from the Oracle program group – the Net 8 Configuration Assistant will launch:

2. Select Local Net Service Name configuration and click the Next button
3. Select **Add** and click the **Next** button

4. Select **Oracle8i database or service** and click the **Next** button

5. Enter a **Service Name AMLIB** and click the **Next** button

**Please Note:** When setting up the **Test** database service name enter a service name of **TELIB**
6. Select TCP for communication and click the Next button

7. Enter the TCP/IP Host Name address of the Oracle database server and click the Next button (Leave the standard port number as 1521 unless your Oracle port number is different)

8. To test that the Oracle Client is setup correctly select Yes, perform a test and click the Next button
9. If test is successful a confirmation message will be displayed: **Connecting...Test successful**

![](image)

10. Click the **Next** button to Finish

* Repeat the above configuration process to create a Service Name (or Alias) for the Amlib Test database EXCEPT using **TELIB** as the service name

**Step 5: Run SQL*Plus To Assign Default Tablespace & Create Amlib Logins**

Once the Amlib instances and tablespaces have been created in **Oracle**, you have to run an “initialisation” SQL script using the **Oracle Sql*plus** program (or use the Amlib **SQLTalk.exe** utility).

The SQL script provides a number of functions:

a. Ensures that the **Oracle Client (SQL*Net / Net8)** is correctly configured and that Amlib will be able to communicate to the **Oracle** database

b. Create Amlib System Administrator login **SYSADM** – which is also the “owner” of all Amlib tables loaded

c. Create **NetOpacs** login **NETOPACS** – which also is the owner of any temporary **NetOpacs** created from searches

d. Assign the tablespace **AMLIB_DB** as the default tablespace to **SYSADM** and **NETOPACS**

e. Create Initial Amlib Logins for libraries (libraries can then creating all required staff logins/passwords using the Amlib **Supervisor** module)

The SQL script makes the following assumptions:

- That the **Oracle SYSTEM** dba login has a password of **MANAGER**
- That a tablespace called **AMLIB_DB** has been created for the **AMLIB** and **TELIB** instances

You will need to alter the sql script if the above assumptions are not applicable for your **Oracle** configuration

- SQL Script File Name: **OracleCreateAmlibLogins.sql**
- Location: **C:\Amlib\Utility\Version 5.1 Database**
The contents of the script include:

```
CONNECT AMLIB SYSTEM/MANAGER;
GRANT CONNECT TO SYSADM IDENTIFIED BY SYSADM;
GRANT DBA TO SYSADM IDENTIFIED BY SYSADM;
GRANT CONNECT TO NETOPACS IDENTIFIED BY NETOPACS;
GRANT DBA TO NETOPACS;
alter user sysadm identified by sysadm default tablesapce amlib_db;
alter user netopacs identified by netopacs default tablesapce amlib_db;
CONNECT TELIB SYSTEM/MANAGER;
GRANT CONNECT TO SYSADM IDENTIFIED BY SYSADM;
GRANT DBA TO SYSADM IDENTIFIED BY SYSADM;
GRANT CONNECT TO NETOPACS IDENTIFIED BY NETOPACS;
GRANT DBA TO NETOPACS;
alter user sysadm identified by sysadm default tablespace amlib_db;
alter user netopacs identified by netopacs default tablespace amlib_db;
```

Step 6: Load Amlib Database into Oracle

Once you have created the Amlib databases in Oracle and installed the Amlib Client software, you can load the Amlib databases into Oracle using the Amlib Upgrade program.

Step 7: Configure SQL.ini Settings

1. On the Amlib application server, navigate to your Amlib folder and open up the SQL.ini file in Notepad:

2. Under the heading [win32client.dll] ensure that the correct database connector is being used:
   - Oracle: comdll=sqlora32

3. If Oracle was selected (comdll=sqlora32) was selected in the [win32client.dll] section then this section is used to determine the Oracle database alias used within the Oracle SQL*Net (also known as Net8 Client)

Under the heading [ORAGTWY] enter in the Oracle file path(s) for the Live database(s):

- REMOTEDBNAME=AMLIB,@AMLIB
- REMOTEDBNAME=TELIB,@TELIB
- SUBSTITUTE=SYSSQL,
- SUBSTITUTE=syssql,
- longbuffer=900000
- MAPERROR=OFF
- fetchrow=100

The format of this keyword is remotedbname={[database name],@[SQL*Net database alias]}

[ORAGTWY]

; This section is for Oracle Router. The REMOTEDBNAME maps the application's
database name to the Oracle SQL*Net connect string. The SUBSTITUTE
; keyword replaces the first parameter with the second parameter. It is mainly
; used to replace the user id in a Catalog Command Query. This's only needed
; when you run Quest against Oracle v7, when you run Quest against Oracle6
; you must remove or comment this line out.

REMTEDBNAME=AMLIB,AMLIB
REMTEDBNAME=TELIB,TELIB
SUBSTITUTE=SYSQL.,
SUBSTITUTE=sysql.,
longbuffer=9999999
MAPERROR=OFF
fetchrow=100
SECTION 3: BACKUPS

This is relevant to users that are running on Microsoft SQL Server.

In all versions of SQL Server there are two recovery models for databases, Simple and Full. The main difference is how many of the transactions are logged for recovery purposes. If customers are happy to be able to go as far back as their latest complete backup then Simple recovery more will suffice and the log sizes will be managed by SQL Server. If point-in-time recovery is required then Full recovery must be used, in this mode in order for the logs to be cleared they must first be backed up.

For the full version of SQL server please download the SQL Server 2008 Maintenance Plan PDF guide, under Database Backup and Log Files:
https://www.oclc.org/support/services/amlib/documentation/technical-documents.en.html

One of the functionalities that is not included with an Express version of SQL Server is the SQL Server Agent which is used in scheduling and managing maintenance plans. This leaves two options for scheduling database backups and maintenance:

1. Use the Amlib Backup management utility.
   This requires at least .NET 3.5 to be installed on the machine that will run the backups. Windows Server 2000 does not support the .NET framework, therefore any customer running Server 2000 will need to implement option 2.
2. Use windows task scheduler to run a batch file and SQL script

The Amlib Backup management utility installer and guide is available from the OCLC Website.

Amlib Backup Manager Installation Guide, under Database Backup and Log Files:
https://www.oclc.org/support/services/amlib/documentation/technical-documents.en.html

Amlib Backup Manager Installation Setup, under Download and Software Updates>Utilities:

The batch file, SQL script and documentation can also be downloaded from the following locations.

SQL Script Backup Guides, under Database Backup and Log Files:
https://www.oclc.org/support/services/amlib/documentation/technical-documents.en.html

Backup Scripts for SQL Server 2005 script, under Download and Software Updates>Utilities:

Backup Scripts for SQL Server 2008 script, under Download and Software Updates>Utilities:

If you require your username and password please contact the support helpdesk.
SECTION 4: TROUBLESHOOTING TIPS

The first step in troubleshooting problems that you may be experiencing with Amlib (Client or NetOpacs) connecting to the database is to first check the following:

- Can you connect to the Amlib database using the Amlib Client on the server?
- Can you connect to the Amlib database using the Amlib Client from another workstation?

The next step is to try and isolate the problem and ensure that the problem is not due to the hardware, network or firewall.

Step 1: Check Communication to Database Server using Microsoft Port Query

Microsoft Port Query is an easy to use tool that enables you to test whether you can connect from a Workstation (or Web Server) to the database server, and whether the RDBMS is listening for connection requests.

1. Launch the Microsoft Port Query program which will be located:
   - Amlib Client: c:\amlib\utility\PortQryUI\portqueryui.exe
   - NetOpacs: c:\netopacs\utility\PortQryUI\portqueryui.exe
   - ZServer: c:\zserver\utility\PortQryUI\portqueryui.exe

   (Please Note: Replace c:\amlib or c:\netopacs with the actual path where the applications have been installed)

2. Enter the Destination IP address of database server used when installing Amlib (for example: tardis, 127.0.0.1, localhost, etc.)

3. Select the Manually input query ports option
4. Ports to query:
   - If using Microsoft SQL Server enter: 1433
   - If using Oracle enter 1521 (older versions of Oracle may be using 1525)

5. Protocol: TCP

6. Then click the Query button to start the search

**Query Results**

1. If the Query result is **LISTENING** (for example: TCP port 1433 (ms-sql-s service): LISTENING) then this indicates:
   - The Workstation (or Web Server) can communicate to the database server **OK**
   - You will need to proceed to the next level of *Amlib* troubleshooting to identify the problem you are experiencing

2. If the Query result is **NOT LISTENING** (for example: TCP port 1433 (ms-sql-s service): NOT LISTENING) then this indicates:
   - The Workstation (or Web Server) is unable to communicate to the RDBMS on the database server

   You should refer this problem to your organisation’s database or network administrator to follow up.

Possible reasons why it is unable to communicate to the RDBMS on the database server:

- The database server is not running
- The database server is disconnected from the network
- The workstation (or web server) is disconnected from the network
- There is a problem with the network (for example: switch is faulty, DHCP is not running, etc.) or network configuration
- The RDBMS is not running on the database server (check in Windows Services whether the RDBMS (*Microsoft SQL Server* or *Oracle*) is running
- The enterprise firewall is preventing connectivity via this Port
- The workstation firewall (for example: *Windows XP Service 2 firewall*) is preventing connectivity via this Port
- There a problem with hardware (for example: network card in either database server, workstation or web server)
3. If the Query result is **FILTERED** (for example: TCP port 1433 (ms-sql-s service): FILTERED) then this indicates:

   - the enterprise firewall is preventing connectivity via this Port
   - the workstation/server firewall (for example: Windows XP Service 2 firewall) is preventing connectivity via this Port

You should refer this problem to your organisation’s database or network administrator to follow up.

**Step 2: Next Level of Amlib Troubleshooting**

**Message Unable to connect to database**

![Connect](image)

A message **“Cannot connect to database”** is displayed if the PC is unable to connect via the WAN (or if SQL.ini is not correctly configured).

The following steps can be used to track down the problem:

1. Review the RDBMS error message displayed on the “cannot connect” screen – for example in the above example refers to **Error No. 20016...SQL Server does not exist...** is a SQL Server error and should be following up with your database administrator (the error number is **not** an Amlib error number)

2. Can the PC connect to the database server?
   - Refer to the previous section: Check Communication to Database Server using Microsoft Port Query

3. If step 2) above is OK, then ensure that you DO NOT have any ODBC Data Sources with the same name as the database (for example: make sure there is NOT an ODBC data source called AMCAT, AMLIB, AMLOCAL or AMSTATS)
   - In Windows: Go to Control Panel > Administrative Tools > Data Sources (ODBC), and check within the User DSN, System DSN or File DSN tabs
4. If step 3) above is OK, then identify whether the SQL.ini is correctly configured or whether there is a connection error:
   - To test start the `\amlib\upgrade.exe` SQL interface program:
     a) From the menu, select File > Advanced Login – the Advanced Login prompt will display:
        ![Advanced Login dialog box]
        b) Enter the login of NETOPACS, the password (usually NETOPACS) and database AMLIB and click the OK button
        c) If Upgrade is able to connect OK to the selected database and will return to the main Upgrade screen and display the username and database
        d) For SQL Server RDBMS - repeat the above Advanced Login step for each other database (AMCAT, AMLOCAL and AMSTATS) to see whether the problem is due to being unable to connect to only 1 of the databases

If Upgrade is unable to connect to the selected database then take a detailed copy of the displayed error message (for example: press [PrtScn] on your keyboard and paste into a Word document) and contact Amlib Support for further assistance.

![Login Error dialog box]

It is also suggested that you take a note of the Error number and research with the RDBMS vendor the explanation and resolution for the Error number:
   - For Microsoft SQL Server – go to http://support.microsoft.com
   - For Oracle – go to http://www.oracle.com/support/index.html
Some of the reasons that the **Upgrade.exe** is unable to connect to the selected database:

- The database does not exist within the RDBMS (for example: if an administrator had deleted the **AMLIB** database)
- The administrator had moved the **Amlib** databases to another server
- The database server has insufficient disk space
- The **Amlib SQL.ini** configuration file (located in the c:\amlib for the **Amlib Client**, or c:\netopacs for the **NetOpacs** module) is not correctly configured – see: [Configure SQL.ini Settings](#) for more information
- For libraries using **Oracle** RDBMS – the **Oracle Net8 (SQL*Net)** Client is not correctly configured (using the **Oracle TNSPING** utility on the Workstation to test)
- For libraries using **Microsoft SQL Server** – an old version of the Windows MDAC (ODBC) drivers are installed

5. If step 4) above is OK, then perhaps the **Amlib** database connection settings held in \(\{\text{windows}\}\amlib.ini\) are incorrect (these are different to the **DIY DefaultUser** and **Login** settings)

### Advanced Support Note for Oracle Version 8 Client

**Unable to Retrieve Rows from the Database**

**OCLC** has identified some problems that some workstations and web servers using **Oracle 8 Net8 (SQL*Net)** Client and **Amlib**:

- The PCs would “hang” when trying to login to **Amlib** and display a message that it is unable to connect to the database
- When trying to using SQLTalk to troubleshoot, you can connect to the database but SQLTalk would hang when trying to retrieve rows from any tables (for example: `select * from borrower`)
Action Taken:

- In the Windows registry (regedit) within HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ create a new String value of ORAOCI with a value of ORACLECLIENT8.DLL
- If problem still occurs rename or remove the file c:\amlib\OCIW32.DLL especially since this file will already exist in the Oracle Client installation folder.
- Technical Notes from Centura using OCIW32.DLL:
  In CTD 1.1.1, the Oracle router utilizes an Oracle DLL named OCIW32.DLL. As the Oracle documentation describes the function of this library, it uses the 'variable' ORAOCI to determine the name of the Oracle client DLL to load. If ORAOCI is not defined, OCIW32 will search through a predefined list of known Oracle client DLL names (most recent to least recent releases) until it either finds one or exhausts the known names and returns an error. The version of OCIW32.DLL that ships with CTD has a predefined list of Oracle client DLL names which predates the release of Oracle 8. If a particular workstation has only Oracle 8 files installed, the Oracle client DLL will not be found; this will have a name like ORA803.DLL. To correct this problem, either delete or rename the OCIW32.DLL that comes with CTD so that the Oracle router will load the OCIW32.DLL released by Oracle which knows about the Oracle 8 client DLL names, or define the variable ORAOCI to point to ORA803.DLL (or whatever name is current). This variable is located in the registry, and the CTD release notes contain instructions on how to locate it and set its value.

Cannot Connect User

When the Amlib client is installed on a Windows 7 machine, an amlib.ini file is placed in the C:\Windows (in older machines this may be the C:\Winnt folder). This file contains the SQL Server login details that allow the Amlib client to connect to the SQL databases.

Typically the [Special] section of the amlib.ini file would contain the following information:

- DatabaseUser=:+,VJxUs:y[e[GlwQmJdU#V:,Z%E%?%d\xb;\6Rpv.\$/SWUXB[dv]_K*]NjIR>lkQSf.
- DatabasePw=:+,VJxUs:y[e[GlwQmJdU#V:,Z%E%?%d\xb;\6Rpv.\$/SWUXB[dv]_K*]NjIR>lkQSf.

These settings are encrypted version of the SYSADM/SYSADM login (the default RDBMS login used for connecting the Amlib client to the SQL databases) – which are configured during installation:
Occasionally (due to various permissions issues), the installer is unable to write to the `amlib.ini` file and the DatabaseUser and DatabasePw settings are left blank:

- DatabaseUser = 
- DatabasePw = 

If this occurs, the user has several choices:

1. If you wish to use the default SYSADM/SYSADM login, you can copy in paste in the following settings (replacing the blank ones in the file):
   - DatabaseUser=:+,VJxUaS:ye[GLwQmJdU#V;Z%E%?%d\xb;\{6RpV./$/SWUXB(dV[_K^*]Nl]R>!kQSbf.
   - DatabasePw=:+,VJxUaS:ye[GLwQmJdU#V;Z%E%?%d\xb;\{6RpV./$/SWUXB(dV[_K^*]Nl]R>!kQSbf.

2. You can type in the RDBMS login you are using (this login must also have been setup in SQL server against the individual Amlib databases

3. You can use the `nopassword.exe` application (C:\Amlib\nopassword.exe) to generate an encrypted login and copy this into the Windows amlib.ini file
   - See: Appendix B: Generate Encrypted RDBMS Password for further information

Please Note: The user may need to adjust the folder and/or file permissions to allow the login details to be written into the amlib.ini file.

Addendum: Under certain exceptional circumstances, a copy of the amlib.ini file may also be found in the Users Virtual Store folder:

- C:\Users\User Name\AppData\Local\VirtualStore\Windows\amlib.ini

This also may need to be adjusted.
Frequently Asked Questions

Question: How much space do I need to have on my server?

- This will vary from library to library, depending on the number of bibliographic records to be held in the database. Generally libraries should ensure they have at least 5 Gb free space on their database server.

Question: Do I need to have a completed backup of my system before proceeding? (Server Migrations Only)

- Yes. OCLC (UK) Ltd recommends that the library verify that it has an up-to-date backup of its database (for example: from the previous night) before installing any updates. You should also make sure that your tape backup includes a backup of your Amlib client folder (for example: C:\Amlib).

Question: Do all users need to be logged out of Amlib? (Server Migrations Only)

- Yes. All users should be completely logged out from all Amlib client modules.
- Libraries using the NetOpacs module should ensure that this program is also shutdown.

Question: Can OCLC (UK) Ltd install Amlib for me?

- Yes. OCLC (UK) Ltd can arrange for the remote installation for a small fee.

Question: How do I know whether Amlib is loaded from my local PC? (Server Migrations Only)

1. Right-click on the Amlib icon on your desktop and select Properties – the Amlib Toolbar Properties window will display.
2. The Target field will show you where your Amlib is installed:
   a. If it has something like C:\Amlib (or D:\Amlib, E:\Amlib depending on the hard drives in your computer) then it is installed locally.
   b. If it starts with two back slashes (\\) and then a name or IP address, it is installed on a server:

![Screenshot of Amlib Toolbar Properties window]
3. If you are having trouble identifying where Amlib is installed please contact your IT Department or Amlib Support for assistance.
Database Structure for Microsoft SQL Server (MSSQL)

Within any one Amlib installation there is the facility to configure up to five (5) separate database areas, which include:

1. Circulation Database (**LIB** suffix): Item, borrower and circulation data
2. Catalogue Database (**CAT** suffix): Catalogue and authority data
3. Parameter Database (**LOCAL** suffix): System parameters (for example: loan settings)
5. Web Database (**WEB** suffix): Web results

Amlib then uses a two-character prefix to designate whether the database is a Live, Test or other (user-defined) database – for example:

- **AM** (Live database prefix)
- **TE** (Test database prefix)

Therefore the databases required for the Live and Test environments using MSSQL would be:

**Live Environment Databases**
- AMCAT
- AMLIB
- AMLOCAL
- AMSTATS
- AMWEB

**Test Environment Databases**
- TECAT
- TELIB
- TELOCAL
- TESTATS
- TEWEB

Please Note: Many existing Amlib customers (installed prior to version 5.x) have a database structure that consists of four (4) database areas (**AMCAT**, **AMLIB**, **AMLOCAL** and **AMSTATS**), with the data for the **AMWEB** database contained within the **AMCAT** database.

Database Setup for Oracle

Most libraries where Amlib is running on Oracle choose to create only one (1) database area with the five (5) databases that normally comprise the Live or Test environment consolidated into a single “instance”. This is done to reduce the administration and performance overheads by reducing the number of “instances” from 10 (5 for Live and 5 for Test) to just 2.

So the standard Live and Test database “instances” created for Oracle are:

**Live Environment Instance**
- AMLIB

**Test Environment Instance**
- TELIB
APPENDICES

Appendix A: Silent Mode Command Line Parameters

The Amlib Client 5.4 installer features the option to install with silent mode command parameters - ideal if you wish to automatically distribute to Amlib staff workstations as part of a login script.

For example:

- Amlib53Setup.exe /VERYSILENT /SUPPRESSMSGBOXES /NOCANCEL /DIR="C:\Amlib"

(Installs the Amlib Client 5.4 silently to the C:\Amlib location on the workstation)

Details of available parameters are:

/SILENT, /VERYSILENT
Instructs Setup to be silent or very silent. When Setup is silent the wizard and the background window are not displayed but the installation progress window is. When a setup is very silent this installation progress window is not displayed. Everything else is normal, so for example: error messages during installation are displayed unless disabled using /SUPPRESSMSGBOXES

If a restart is necessary and the /NORESTART command isn't used (see below) and Setup is silent, it will display a Reboot now? message box. If it's very silent it will reboot without asking.

/SUPPRESSMSGBOXES
Instructs Setup to suppress message boxes. Only has an effect when combined with /SILENT and /VERYSILENT.

The default response in situations where there's a choice is:

- Yes in a Keep newer file? situation
- No in a File exists, confirm overwrite. situation
- Abort in Abort/Retry situations
- Cancel in Retry/Cancel situations
- Yes (=continue) in a DiskSpaceWarning/DirExists/DirDoesn'tExist/NoUninstallWarning/ExitSetupMessage/ConfirmUninstall situation
- Yes (=restart) in a FinishedRestartMessage/UninstalledAndNeedsRestart situation

5 message boxes are not suppressible:

- The About Setup message box
- The Exit Setup? message box
- The FileNotInDir2 message box displayed when Setup requires a new disk to be inserted and the disk was not found
- Any (error) message box displayed before Setup (or Uninstall) could read the command line parameters
- Any message box displayed by [Code] support function MsgBox.

/NOCANCEL
Prevents the user from cancelling during the installation process, by disabling the Cancel button and ignoring clicks on the Close button. Useful along with /SILENT or /VERYSILENT.

/NORESTART
Instructs Setup not to reboot even if it's necessary.

/RESTARTEXITCODE=exit code
Specifies the custom exit code that Setup is to return when a restart is needed. Useful along with /NORESTART. Also see Setup Exit Codes.

/DIR="X:\dirname"
Overrides the default directory name displayed on the Select Destination Location wizard page. A fully qualified pathname must be specified.

/PASSWORD=password
Specifies the Password (Serial Key) to use.
When an invalid password is specified, this command line parameter is also ignored.

/\GROUP=\"folder name\"
Overrides the default folder name displayed on the Select Start Menu Folder wizard page.

/\NOICONS
Instructs Setup to initially check the Don't create any icons check box on the Select Start Menu Folder wizard page.

/\COMPONENTS=\"comma separated list of component names\"
Overrides the default components settings. Using this command line parameter causes Setup to automatically select a custom type.

(You will need to contact Amlib Support for a complete list of components that are available to choose from, depending on which installer is being used)

/\TASKS=\"comma separated list of task names\"
Specifies a list of tasks that should be initially selected or deselected. To deselect a task, prefix its name with a "!" character.

Only the specified tasks (and their children) will be selected; the rest will be deselected. Use the /\MERGETASKS parameter instead if you want to keep the default set of tasks and only select/deselect some of them.

Examples:
Deselect all tasks, then select the "desktopicon" and "fileassoc" tasks:
/\TASKS=\"desktopicon\",\"fileassoc\"

Deselect all tasks, then select a parent task item, but exclude one of its children:
/\TASKS=\"parent\",\!parent\child\"

/\MERGETASKS=\"comma separated list of task names\"
Like the /\TASKS parameter, except the specified tasks will be merged with the set of tasks that would have otherwise been selected by default.

If UsePreviousTasks is set to yes, the specified tasks will be selected/deselected after any previous tasks are restored.

Examples:
Keep the default set of selected tasks, but additionally select the "desktopicon" and "fileassoc" tasks:
/\MERGETASKS=\"desktopicon\",\"fileassoc\"

Keep the default set of selected tasks, but deselect the "desktopicon" task:
/\MERGETASKS=\!desktopicon\"

/\LOG
Causes Setup to create a log file in the user's TEMP directory detailing file installation and [Run] actions taken during the installation process. This can be a helpful debugging aid. For example, if you suspect a file isn't being replaced when you believe it should be (or vice versa), the log file will tell you if the file was really skipped, and why.

The log file is created with a unique name based on the current date. (It will not overwrite or append to existing files.)

The information contained in the log file is technical in nature and therefore not intended to be understandable by end users. Nor is it designed to be machine-parseable; the format of the file is subject to change without notice.

/\LOG=\"filename\"
Same as /\LOG, except it allows you to specify a fixed path/filename to use for the log file. If a file with the specified name already exists it will be overwritten. If the file cannot be created, Setup will abort with an error message.

/\LOADINF=\"filename\"
Instructs Setup to load the settings from the specified file after having checked the command line. This file can be prepared using the /\SAVEINF= command as explained below.
Don't forget to use quotes if the filename contains spaces.

/\SAVEINF=\"filename\"
Instructs Setup to save installation settings to the specified file.
Don't forget to use quotes if the filename contains spaces.
Appendix B: Generate Encrypted RDBMS Password

The `nopasswd.exe` utility is located in the `C:\Amlib` folder after installation.

1. Double-click on the `nopasswd.exe` application to open the Encrypt/decrypt screen will display:

2. Type in the Password (for which you would like to generate an encrypted string) – for example: DODGER

3. Press the `<Tab>` key

4. The encrypted password will display in the Code box – for example: 
   @8eT5zpQ^2c^Le-R+QK:1<1hkD7/<=9c(w%gat3_9f\m+u>&;Z0[\Y>H.E6qWqZ*o."q9

5. Copy encrypted password for use
Appendix C: MICROSOFT SQL SERVER 2008 R2 install

Step 1: SQL Server 2008 Setup

1. Download the Express (R2) version of SQL Server 2008: SQLEXPRWT_x86_ENU.exe (32-bit server) or SQLEXPRWT_x64_ENU.exe (64-bit) from the Microsoft Download Center:
2. Double-click on the application to launch the installer:
3. Select the **New installation or add new features to an existing installation** link – the **License Terms** screen will display:

![License Terms screen](image)

4. **Tick** the **I accept the license terms** box and click the **Next** button – the **Support Files** will be installed:

![Support Files screen](image)
5. Once completed – the Feature Selection screen will display:

6. Click the **Select All** button and then the **Next** button – the Instance Configuration screen will display:

7. Type in a Named instance or leave as default: **SQLEXPRESS** and click on the **Next** button
8. The Server Configuration screen will display:

9. Click the Next button – the Database Engine Configuration screen will display:

10. **IMPORTANT**: Ensure that the **Mixed Mode (SQL Server authentication and Windows authentication)** radio button is selected

11. **Enter password** and **Confirm password** – for example: SYSADM/SYSADM
    (Please ensure that you keep a record of this)

12. Click the **Next** button
13. The Error Reporting screen will display:

14. Click the Next button – the SQL server will begin installing:
15. Once completed, the following screen will display:

![SQL Server 2008 R2 Setup Complete](image)

16. Click on the Close button

The installation of the SQL Server 2008 R2 is now complete.